
Appendix C: Office 2004, Menu by Menu 751

This is the Title of the Book, eMatter Edition

Appendix Cappendix

c

Office 2004, Menu by
Menu

Because Microsoft Office 2004 is four big programs that work together, there are a
lot of menus to cover—one set for each program. While some of these menus
overlap, there are some significant differences. These menus also change depend-
ing on what’s selected in your currently open document.

This special online appendix to Office 2004 for Macintosh: The Missing Manual
takes the menus program by program, so you can look up what you need easily.
It’s designed as a bonus appendix for owners of the book; the page-number cross-
references here, for example, are keyed to the pages of the book itself.

Application Menu
Like Mac OS X applications everywhere, each Office application has a menu bear-
ing its name, just to the right of the a menu. It contains the Quit command, access
to Preferences, and other commands that pertain to the program as a whole. It also
offers a few Finder commands, potentially saving you a trip to the desktop.

About [Program Name]
Opens a window that displays some legalese and, more importantly, the product
ID for your copy of Office. A Microsoft representative may ask you for this num-
ber when you call a technical support phone number (which you can find by click-
ing the Support button).

The Proofing Tools button doesn’t actually help with proofreading; it just offers
more legalese about any foreign language dictionaries you’ve installed.
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Application Menu Online Registration
In case you clicked Register Later when you first installed Office (see Appendix A),
choose this command when you have the time to go through the registration pro-
cess.

Application Menu Preferences
This command opens up the Preference box, which contains different panels for
various types of settings (these are discussed throughout this book). Keyboard
shortcut:@c-comma (,).

In Entourage, there are two mais sections in the Preferences dialog box:

• General Preferences. Opens Entourage’s General Preferences window, which is
divided into six categories that covers how Entourage works, particularly the
Address Book (Chapter 11) and Calendar (Chapter 10).

• Mail & News Preferences. Opens Entourage’s Mail & News Preferences win-
dow, whose five categories cover how Entourage deals with mail and news mes-
sages (see Chapter 9).

Account Settings (Entourage only)
Opens the Tools ➝ Accounts window, as discussed on page 371.

Work Offline (Entourage only)
Disconnects Entourage from the Internet, so that you can you write email mes-
sages, reply to news messages, or work with tasks, calendar items, or contacts with-
out being interrupted by Entourage’s automatic mail-getting schedule (which
would otherwise remind you every 10 minutes, “Error trying to get online”). Great
for use on planes and in waiting rooms.

Turn Off Office Notifications (Entourage only)
Tells the Office Notifications program (page 406) to stop reminding you about
events, tasks, and documents that you’ve set for follow-up.

Switch Identity (Entourage only)
Switches your Entourage identity, which lets you (or another person using Office)
use a different set of accounts (see page 450). Keyboard shortcut: Shift-@c-Q.

Services
This is a standard Mac OS X menu, listing useful inter-program commands that
mostly do nothing in Office. (That’s because Services generally work only in Cocoa
programs—programs that were written from scratch for Mac OS X rather than
adapted from earlier software, as Office was.) For the full story on Services, see
Mac OS X: The Missing Manual.
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File MenuHide [Program Name]
Hides the current program’s windows from view without minimizing the program
to the Dock. Keyboard shortcut:@c-H.

Hide Others
Hides the windows of all other programs, including the Finder, leaving only win-
dows from the frontmost Office program visible. Keyboard shortcut: Option-@cd-H.

Show All
Brings back all hidden windows of the program you’re using.

Quit [Program Name]
Quits the frontmost program, but before doing so, offers you a chance to save any
changes you’ve made. Keyboard shortcut:@c-Q.

Entourage Menus
Entourage’s menus, not surprisingly, center on manipulating mail and newsgroup
messages, with a whole set of submenus for dealing with tasks, appointments, and
contacts thrown in for good measure.

File Menu
Like any other good Macintosh program, Entourage comes equipped with the File
menu, which is mainly used for working with files on your hard drive—whether
that’s creating new files, saving them, or printing them.

Project Gallery
It’s the top File menu item in all four Office applications, and it opens the Office
Project Gallery window when selected. Keyboard shortcut: Shift-@c-P.

New
Creates a new Entourage file. Since Entourage can create a variety of files, the New
command has its own submenu, filled with commands that creates a new Entou-
rage document or element.

• New. This top item changes, depending on what’s selected in Entourage’s
Folder List window. It might say, for example, New Mail Message, New News-
group message, New Task, and so on. Keyboard shortcut:@c-N.

• Mail Message. Creates a blank email message. Keyboard shortcut: Option-@c-N.

• News Message. Creates a blank newsgroup message.

• Calendar Event. Creates a blank calendar event.
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File Menu • Task. Creates a blank task.

• Note. Creates a blank note.

• Contact. Creates a blank address-book entry.

• Group. Creates a blank group, in which you can gather together contacts.

• Project. Opens the New Project Wizard (page 410) so you can start a fresh
project.

• Custom View. Opens the Edit Custom View dialog box, in which you can name
and define a new custom view in any of Entourage’s functions (Mail, Tasks, and
so on). For more information on custom views, see the box on page 455.

• Folder. Creates a new folder in the Folder List. (Available in Mail and Custom
Views only.) Keyboard shortcut: Shift-@c-N.

• Subfolder. Creates a new subfolder in the folder that’s selected in the Folder
List.

Open
Opens the selected item into its own window, whether it’s an item in the Folder
List (such as a mail folder or the Address Book) or an item inside the browser win-
dow (such as a folder or a contact). The command even tells you what you’re
about to open (“Open Message” for example). Keyboard shortcut:c-O.

Close
Closes the frontmost open window, even if it’s the Progress window. If Entou-
rage’s main window is the only one open, this command closes it. Keyboard short-
cut:@c-W.

Save
Saves any changes made to the frontmost window, whether that window is an
email message (which then gets placed in the Drafts folder) or a contact. If the doc-
ument in the frontmost window hasn’t been changed, then the Save command is
disabled. Keyboard shortcut:@dc-S.

Save As
Saves the frontmost window as another file. This command essentially makes a
copy of the file and closes the original, allowing you to choose a new name and
location for the file.

Save As Custom View
After you’ve performed a search, you can use this menu command to save the
search as a custom view, which can save you time later (see the box on page 455).

,appc.12217  Page 754  Thursday, March 10, 2005  10:22 AM



This is the Title of the Book, eMatter Edition

Appendix C: Office 2004, Menu by Menu 755

File MenuSave As Web Page
(Available in Calendar only.) Lets you save your calendar as a Web page, so that
others on the Internet can see what you’re up to—if you really want that kind of
scrutiny (page 399).

Revert
Throws out any changes that you’ve made to the file in the frontmost window
since you last saved it.

Import
Opens Entourage’s Import window, which lets you bring in information from var-
ious email, personal information manager, and text-based mail and contact files
(page 320).

Export Contacts
Saves Entourage’s contacts as a text file, which you can then use in another pro-
gram (page 435).

Share a Project
Initiates the sharing of a project (page 420).

Subscribe to a Project
Lets you subscribe to a shared project that you or another Entourage user created.

Page Setup
Opens the Page Setup dialog box, in which you can control how Microsoft Office
prints your pages (on which kind of paper, and so on). The options here depend
on the kind of printer you have selected in Print Center.

Print One Copy
Prints a copy of the frontmost window (or the item selected in the main window)
without opening the Print dialog box. Think of it as the fast track to printing. Key-
board shortcut: Option-c-P.

Print
Opens the Print dialog box, in which you can specify the number copies you want
printed, among a multitude of other settings. Keyboard shortcut:c-P.
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Edit Menu Edit Menu
The Edit Menu commands focus on editing tools, whether that means moving text
around in an email message or memo, looking for a text string inside Entourage’s
files, managing message threads, or changing an item’s category.

Undo
Takes back the last thing that you did, like deleting that vital chunk of text by acci-
dent. Keyboard shortcut:c-Z.

Redo
Once you’ve undone something, the the Redo command becomes available, in case
you change your mind. Keyboard shortcut:c-Y.

Cut
Cuts the selected text or object out of the document and puts it on the Clipboard,
ready for pasting into a different window or program. Keyboard shortcut:c-X.

Copy
Copies the selected text or object and puts it on the Clipboard, ready for pasting
into a different window or program. Keyboard shortcut:c-C.

Copy to Scrapbook
Copies to the Scrapbook (page 663). You can store clips on the Scrapbook—and
subsequently paste them—from any Office program.

Paste
Pastes the contents of the Clipboard into a document at the location of the inser-
tion point. Keyboard shortcut:c-V.

Paste From Scrapbook
Pastes a clip from the Scrapbook.

Paste Special
Once you’ve got something on the clipboard, you can choose how Entourage
pastes it from this submenu.

• Paste as Quotation. Pastes the text on the clipboard into an open Entourage
window as an Internet-style quotation—that is, with > brackets in front of each
line, to let your correspondent know you’re quoting back something she wrote.
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Edit Menu• Paste as Plain Text. Removes any formatting, like italics, from the text you’re
pasting. Useful primarily when you’re pasting formatted text from Word into a
plain-text email or newsgroup message.

• Paste as Picture. Pastes whatever is on the clipboard (such as a Word table,
Excel chart, or drawing) as a picture. Useful, and available, only in HTML-for-
matted email messages, and in Notes.

Clear
Deletes the selected text (or object) from the document without putting it on the
clipboard.

Select None
Unselects any object that’s selected in the frontmost window. Keyboard shortcut:
Shift-c-A.

Select All
Selects everything (whether that’s text or objects) in the frontmost window. Key-
board shortcut:c-A.

Duplicate
Duplicates the currently selected item, whether it’s a message or a calendar event.
This command’s wording changes to reflect the kind of object that’s selected; it
may say Duplicate Message or Duplicate Task, for example. (It can’t duplicate
items on a remote server, such as an online email account or a news server.) Key-
board shortcut:c-D.

Delete
Deletes the selected item (such as a mail message, contact, or folder in the Folder
list). Like Duplicate, the Delete command’s wording changes to reflect the item
being deleted, and it can’t be used to delete messages on a news server. Keyboard
shortcut:c-Delete.

Delete Group
Sort of the überversion of Delete—it deletes an entire bunch of grouped messages.
Keyboard shortcut: Option-c-Delete.

Edit Custom View
Opens the Custom Views window (see the box on page 455).

,appc.12217  Page 757  Thursday, March 10, 2005  10:22 AM



This is the Title of the Book, eMatter Edition

758 office 2004: the missing manual

Edit Menu Project Properties
(Project Center only.) Opens the Project Properties window (page 422) of the
selected project. (In other views, this command turns into a placeholder called Get
Properties. It doesn’t do anything.)

Categories
This menu lists Entourage’s categories (a way of labeling your Entourage data, as
described on page 458), and it gives you two commands to use with those catego-
ries: Assign Categories lets you place the selected item (such as a message or a
folder) into one or more of your categories; Edit Categories lets you create, change,
and delete Entourage’s categories.

The prefab categories included in Entourage are: None, Family, Friends, Holiday,
Junk, Personal, Recreation, Travel, and Work.

Projects
This menu lists your projects. You can either assign the selected item (email mes-
sage, note, or whatever) to a project by selecting it or create a new project.

Share Item, Do Not Share Item
Lets you share (or stop sharing) the item via a shared project; see page 420.

Auto Text Cleanup
Auto Text Cleanup contains six tools to help turn email text into cleaner text,
removing some of its gremlins.

• Straighten Quotation Marks. Takes fancy curly quotes and turns them into
standard straight quotes.

• Rewrap Paragraphs. Pulls out the line breaks in the text of a message (see page
341).

• Increase Quoting. Increases the level of Internet quoting (with all of the > signs
on the left margin of the text) by one.

• Remove Quoting. Decreases the level of Internet quoting by one.

• To UPPERCASE. Makes the selected text all capitals.

• To lowercase. Makes the selected text all lowercase.

Decrease Font Size
Makes the text of an incoming message smaller. Keyboard shortcut: Shift-c-
hyphen.
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View MenuIncrease Font Size
Makes the text of an incoming message larger. Keyboard shortcut: Shift-c-=.

Find
Opens Entourage’s Find panel, which you can use to search through messages for a
text phrase (see page 452). Keyboard shortcut:c-F.

Advanced Find
Opens Entourage’s Advanced Find window, where you can use all kinds of criteria
to narrow your search (see page 454). Keyboard shortcut: Option-c-F.

Find Related Items
Lets you search for messages sent to or received from the selected contact.

View Menu
The View Menu’s commands control how Entourage looks and shows you things.
(In Calendar view, this becomes the Calendar menu, but it contains many of the
same commands.)

Previous
Moves to the previous item in the currently selected folder. If a message is open,
the contents of the open window changes to the previous message. Keyboard short-
cut:c-[.

Next
Moves to the next item in the currently selected folder. If a message is open, the
contents of the open window changes to the next message. Keyboard shortcut:c-].

Go To
Choosing one of the items from this submenu does the same thing as clicking the
Mail, Address Book, Calendar, Notes, Tasks, and Custom Views buttons—it
switches to the view of that function.

Toolbars
Hides or shows the toolbar in Entourage’s main window (a space-saving gesture).

Folder List
Hides or shows the Folder List in Entourage’s main window.
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View Menu Preview Pane
Hides or shows the Preview Pane in Entourage’s main window. Keyboard shortcut:
c-\.

Columns
The Columns menu lets you hide or show the various columns in Entourage’s
main list view. The columns that you can toggle are: Links, Online Status, Message
Status, Priority, Attachment, From, Subject, Sent, Received, To, Account, Size, and
Categories.

To save space, hide the ones you rarely consult.

Arrange By
(Mail and Newsgroups only.) Lets you choose how you want to group the mes-
sages in the folder you’re viewing (that is, by subject, sender, and so on).

Internet Headers
Reveals the Internet headers that show where the message has been on its travels
through cyberspace. It works only on messages that are open in their own win-
dows, not on messages in the Preview pane.

Source
Opens the selected message’s HTML source code—including its headers—so you
can take a look at the formatting codes that make it up.

Unread Only
Hides all messages but the ones you haven’t yet read. (Choose the command again
to bring them back into view.) Keyboard shortcut:c-Y.

Flagged Only
Makes flagged messages the only thing that you see in list windows. Keyboard
shortcut: Shift-c-Y.

Expand All
In the folder pane, shows all folders and their subfolders. In the message list, opens
up collapsed groups so that you can see all messages.

Collapse All
In the folder pane, collapses all subfolders; the equivalent of closing all folders’
flippy triangles at once. In the message list, hides all grouped messages so that you
can only see the group headers.
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Message MenuMessage Menu
The Message Menu provides all manner of commands for dealing with messages,
as you may have guessed. (Available in Mail and Newsgroup views only.)

Resend
Resends a selected message in the Sent Items folder. (If a message in the Outbox is
selected, this command says Send Message Now instead, and its keyboard shortcut
isc-Return.)

Send Message Now
(Available when a message you’re composing is open in its own window and
Entourage is online.) Sends an email or newsgroup message.

Send Message Later
(Available when a message you’re composing is open in its own window.) Places
the email or newsgroup message in the Outbox.

Receive Entire Message
If you’ve selected a partially retrieved message, this command tells Entourage to
receive the rest of the story. (If you’ve selected a message in the Out box, this menu
item changes to say Send Message Later.)

Edit Message
Makes a previewed (or opened) message editable, so that you can change its text—
even if you didn’t create the message.

Reply
Creates an outgoing reply message for the selected message, with subject, address,
and date already filled in. If the message comes from a mailing list, the reply will be
addressed to the entire mailing list. Keyboard shortcut:c-R.

Reply to All
Creates a reply to the selected message, preaddressed to every recipient of the origi-
nal message. Keyboard shortcut: Shift-c-R.

Reply to Sender
Creates a reply to the selected message, preaddressed to the sender only. Keyboard
shortcut: Option-c-R.
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Message Menu Forward
Forwards the message to a third party, first permitting you to add your own com-
ments to it before you send it along to someone else. Keyboard shortcut:c-J.

Redirect
Redirects the selected message to someone else, which makes it appear as though it
came from the original sender (see page 343). Keyboard shortcut: Option-@cd-J.

Mark as Read
Marks the currently selected message so that it looks like you’ve already read it (it
stops being bold). Keyboard shortcut:c-T.

Mark as Unread
Marks the currently selected message as unread (it turns bold)—useful if you’ve
already read it but want to pretend as if you haven’t. Keyboard shortcut: Shift-c-T.

Mark All as Read
Marks all messages in the selected folder as having been read. Keyboard shortcut:
Option-c-T.

Flag
Marks the currently selected message (or messages) with a flag in the list view. The
flag also shows up next to the folder in the Folder List where the message is cur-
rently filed (see page 346). Keyboard shortcut:c-’.

Flag for Follow-up
Opens the follow-up window (a specialized kind of task window) in which you can
set a time to be reminded to take action concerning the flagged message (see page
346). It also puts a flag next to the item in the list view, and next to the item’s
folder in the Folder List. Keyboard shortcut: Shift-c-’.

Clear Flag
Removes the flag from a flagged message.

Insert
The submenu commands here let you insert, into an outgoing email or newsgroup
message, one of the following items:

• Picture. Opens a Choose a File box for you to choose a graphics file to attach to
a message or, if HTML is turned on, to place in the body of the message.
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Message Menu• Background Picture. Opens a Choose a File box as above, except that Entou-
rage sizes the picture you use to fill the body of the message. Your typing
appears over the picture, provided you choose a contrasting font color.

• Sound. Opens a Choose a File box for you to choose a sound file, such as a
WAV file, to attach to an email message as an attachment.

• Movie. Opens a Choose a File box, exactly as for a sound. Entourage inserts the
movie into an HTML email as in a Web page or attaches it.

Remove Background Picture
Deletes a background picture, if you inserted one using the above command.

Signature
Lets you select the signature for your outgoing message (see page 363).

Priority
Lets you set a priority for your outgoing Entourage message (which will be flagged
accordingly in your recipient’s email program, if it understands such priority set-
tings).

Security
This submenu, available when you’re composing a new message, lets you apply
two encryption features that help prevent evildoers from reading your email dur-
ing its electronic journey. Because you and your recipients need to share each
other’s digital certificates (files that identify you as the sender and decode the
encrypted messages), you’ll usually use this feature when a corporate administra-
tor has gotten everyone set up for it.

• Digitally sign message. Adds the file that digitally identifies you as you. Usually
your administrator purchases these certificates for everyone using the network.

• Encrypt message. Scrambles the message so that only you and the others with
the right certificates can read it.

After Sending, Move To
Lets you set a destination folder for your outgoing message. Once you’ve sent it,
Entourage will move the message to the selected folder.

Move To
This menu command moves the selected message or messages to a folder in the
list—a great feature when you’re slogging through a mass of messages, trying to
clean them up. Its submenu offers a list of folders and a special Move To Folder
command.
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Format Menu • Folder list. This is a list of Entourage folders to which you can move the
selected message.

• Move To Folder. Opens a list of all of Entourage’s folders; you can move the
selected message to any of them. You can also create a new folder using the con-
trols in this window. Keyboard shortcut: Shift-c-M.

Priority
This menu sets the priority of the selected message from one of five possible
choices: Highest, High, Normal, Low, and Lowest.

Apply Rule
Applies mail rules (see page 353) to the selected message or messages, even though
they’ve already been downloaded to your machine. The submenu shows two
things: your list of individual rules and All Rules, which applies all of your rules to
the selected messages.

Add Attachments
Lets you add an attachment to a message that you’re creating (see page 364).

Save All Attachments
Opens up a Save dialog box in which you can save any file attachments to the cur-
rently selected message onto your hard drive (see page 349). This command is dis-
abled if a message doesn’t have any attachments.

Remove All Attachments
Removes any attachments to the selected message. Great for stripping away annoy-
ing VCF files.

Format Menu
Even though email and news messages both trace their origins to plain text (which
doesn’t contain much in the way of formatting), the advent of HTML email lets
you use a variety of formatting in your missives. Those commands are thought-
fully grouped in the Format menu.

HTML
If HTML is turned on, then all of the Format menu commands listed below are
available. Otherwise, most of the commands below are dimmed, and you’ll pre-
pare your email messages using plain, unformatted text only.

Style
Lets you choose from five different styles for your text, detailed below:
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Format Menu• Regular Text. You guessed it—plain vanilla text.

• Bold. Makes the selected text bold. Keyboard shortcut:c-B.

• Italic. Makes the selected text italic. Keyboard shortcut:c-I.

• Underline. Underlines the selected text (and makes it look like a hyperlink—
great for practical jokes). Keyboard shortcut:c-U.

• Fixed Width Font. Uses a fixed-width font, such as Monaco. A fixed-width font
is one in which each character takes up the same amount of horizontal space:
that is, an “i” takes up as much space as an “m,” making it easier for you to line
up text in columns.

Font
Lists all of the fonts installed on your Mac. Choose one to use in your message.

Font Size
Lets you choose a specific point size for your text, just as you would when format-
ting text in Word (page 108).

Font Color
Lets you choose a color for your HTML-based email fonts. It lists 16 colors: Black,
Maroon, Green, Olive, Navy, Purple, Teal, Gray, Silver, Red, Lime, Yellow, Blue,
Fuchsia, Aqua, and White—plus Other, which lets you use the color picker to mix
your own color (page 689).

Background Color
Lets you choose a shade for the background of your HTML email messages.

Character Set
Lets you choose a language character set for your mail: Western European, Central
European, Chinese, Cyrillic, Greek, Japanese, Korean, Turkish, or Unicode. This
submenu comes factory set to Automatic, meaning that Entourage can detect the
languages used in incoming messages. If you get a message loaded with nonsense
characters, try choosing the correct language manually.

Alignment
Chooses alignment for the selected paragraphs: Left, Center, or Right.

Numbered List
Turns the selected text into an HTML numbered list.
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Tools Menu Bulleted List
Turns the selected text into an HTML bulleted list.

Increase Indent
Indents the selected paragraphs (when creating a quotation, for example).

Decrease Indent
Decreases the indent level.

Insert Horizontal Line
Inserts a horizontal rule into an HTML formatted outgoing message (page 297).

Tools Menu
Where would a Microsoft program be without a Tools menu? Here you’ll find
commands that deal with Entourage’s general utility operations.

Run Schedule
Here’s a look at each item in the submenu (see page 328 for more on schedules):

• Empty Deleted Items Folder. Empties the Deleted Items folder of its contents.

• Send & Receive All. Sends all queued messages and gets mail from all accounts.

• Send All. Sends all waiting messages.

• Edit Schedules. Opens the Schedule window, where you can create, edit, and
delete schedules.

Send & Receive
This command’s submenu lets you send your waiting outgoing mail and down-
load any email waiting for you.

• Send & Receive All. Sends all waiting messages and gets mail from all accounts.
Keyboard shortcut:c-K.

• Send All. Sends all waiting messages (but doesn’t download incoming mail).
Keyboard shortcut: Shift-c-K.

• List of accounts. Every account you have in Entourage is listed here. By select-
ing the account name, you make Entourage send and receive messages for that
one account.

Spelling
Checks the spelling in your message. Keyboard shortcut: Option-c-L.
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Tools MenuChange Dictionary
Use the Change Dictionary submenu to choose your dictionary language (for
spelling and grammar checks) from the following choices: Danish, Dutch, English
(Australian), English (UK), English (US), French, French Canadian, German, Ital-
ian, Norwegian Bokmal, Norwegian Nynorsk, Spanish, and Swedish.

AutoCorrect
Opens Entourage’s AutoCorrect settings window, in which you can set how Entou-
rage automatically attempts to fix your mistakes and add formatting to your mes-
sages, exactly as in Microsoft Word (see page 91).

Dictionary
Opens the Office definitions dictionary and looks up the selected word in it.

Check Names
Searches directory services (see page 356) for the name or email addresses that
you’ve entered in the To, CC, or BCC fields of a message. Keyboard shortcut: Shift-
c-C.

Add to Address Book
Adds the email address of the recipient or sender of a message to your address
book—a brilliant and useful feature. Keyboard shortcut:c-=.

Open Links
Opens a list of links (see page 347) to the selected item or message.

Link to Existing
Lets you link to an existing Message, Calendar Event, Task, Note, Contact, Group,
or File, using the Links dialog box (page 456).

Link to New
Lets you link to a Mail Message, News Message, Calendar Event, Task, Note, Con-
tact, or Group that you haven’t yet created, and offers you the chance to create it in
the process.

Scrapbook
Opens the Office Scrapbook (page 663).

Junk E-Mail Protection
Opens the Junk E-Mail Protection window, in which you can set the filter’s
options (page 354).
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Window Menu Mailing List Manager
Opens the Mailing List Manager, in which you can set options for dealing with
mailing lists.

Rules
Opens the Rules window, in which you can create, edit, or delete message rules
(see page 353).

Newsgroup Settings
Lets you set character-set options for the selected newsgroup. Useful if you habitu-
ate international newsgroups.

Tools on the Web
Launches your Web browser and opens a page on the Mactopia Web site that
offers additional templates for download, online White and Yellow Pages, and
Office tips.

Directory Services
Opens the Directory Services window, where you can search for someone’s email
address or name from a directory service server.

Signatures
Opens the Signatures window, in which you can create, edit, or delete signatures
for your messages.

Schedules
Opens the Schedules window, in which you can create, edit, or delete schedules.

Accounts
Opens the Account window, in which you can create, edit, or delete mail, news,
and directory service accounts (page 325).

Window Menu
The Window menu corrals all of the window-related Entourage commands in one
place.

Minimize Window
Sends the frontmost Entourage window to the Dock. Keyboard shortcut:c-M.
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Help MenuZoom Window
Does the same thing as the green zoom button in the upper-right corner of the
window: resizes it to its full size, so that it fills up most of the screen.

Progress
Opens the Progress window, which shows how network operations are progress-
ing. Keyboard shortcut:c-7.

Error Log
Open Entourage’s Error Log, which tells you about any problems the program had
in sending or receiving your messages. Keyboard shortcut:c-9.

Cycle Through Windows
Moves from one open window to the next, one at a time. Keyboard shortcut:c-~.

Window List
All of the open windows are listed at the bottom of the Window menu. To switch
to an open window, select it from this list.

Bring All to Front ]
Makes all open, nonminimized Entourage windows visible, pulling them out from
behind other windows.

Help Menu
The Help menu gives you access to resources for learning about and troubleshoot-
ing Office. Some are stored in the Help system that Office installed on your com-
puter; others are on Microsoft’s Web site.

Entourage Help
Opens up Entourage’s online help, as described in Appendix B.

Use the Office Assistant
Turn the Office Assistant (Max, the animated Mac Plus) on or off by selecting this
menu command.

Check for Updates
Launches the Microsoft AutoUpdate program (page 8).

,appc.12217  Page 769  Thursday, March 10, 2005  10:22 AM



This is the Title of the Book, eMatter Edition

770 office 2004: the missing manual

Scripts Menu Downloads and Updates
Opens your Web browser to Microsoft’s page of free updates and patches for
Office.

Visit the Product Web Site
Opens your Web browser to Microsoft’s home page for its Macintosh products.

Send Feedback on Entourage
Opens your Web browser to a Microsoft Web page containing a simple feedback
Web form.

Scripts Menu
Entourage works well with AppleScript—so well that it reserves an entire menu for
scripts. You can use one of the included scripts, and you can add your own scripts
to this menu.

Create Event from Message
Attaches the selected message’s text to a new Entourage Event (a nifty trick if the
message contains directions to a party). Keyboard shortcut: Control-E.

Create Note from Message
Attaches the selected message’s text to a new Entourage Note. Keyboard shortcut:
Control-N.

Create Task from Message
Attaches the selected message’s text to a new Note. Keyboard shortcut: Control-T.

Insert Text File
Lets you insert a text file. Browse to the file you wish to insert, select it, and its text
appears in your message. Almost as if by magic.

Open Email Folder
Opens the window from where you may select the folder to open.

Save Selection
Also opens the window where you can save your current selection as an Entourage
Email Selection.
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Excel MenusExcel Menus
These menus are the same no matter what kind of document is open.

File Menu
The commands in the File menu open Excel workbooks, whether you’re opening
them, saving them, or printing them.

Project Gallery
It’s the top File menu item in all four Office applications, and it opens the Office
Project Gallery window. Keyboard shortcut: Shift-c-P.

New Workbook
Creates a new Excel workbook. Keyboard shortcut:c-N.

Open
Opens Excel’s Open dialog box, which you can use to navigate to a file for Excel to
open. Keyboard shortcut:c-O.

Close
Closes the frontmost Excel workbook window. If the workbook has unsaved
changes, Excel will ask you if you want to save those changes. Keyboard shortcut:
c-W.

Save
Saves any changes to the frontmost window. If the file is a new, unsaved work-
book, Excel prompts you to name it and choose a location for it. Keyboard short-
cut:c-S.

Save As
Saves the frontmost window as another file. This command essentially makes a
copy of the file and closes the original file, allowing you to choose a new name and
location for the file, if you want.

Save as Web Page
Saves the frontmost Excel workbook as a Web page, converting graphics and
graphs to the right kind of graphic formats, and saving all of the data in HTML
tables (page 560).
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Excel Menus Save Workspace
Memorizes the positions and sizes of any open workbook windows into a separate
file. Later, when you open that file, all of the workbooks will be opened to the same
size and position.

Web Page Preview
Shows you, in your Web browser, what your workbook will look like as a Web
page.

Page Setup
Opens the Page Setup dialog box, where you can set up your Excel printouts. The
options depend on the kind of printer you have selected in the Chooser.

Print Area
Offers two commands:

• Set Print Area. Lets you drag to select the cells you want to print.

• Clear Print Area. Undoes the Set Print Area command, so that nothing is
selected for printing.

Print Preview
Opens up the Print Preview window, which shows how a workbook will look when
you print it.

Print
Prints the frontmost document on the printer selected in the Chooser. It opens the
Print dialog box, in which you can specify how many copies you want printed and
make other printing-related settings. Keyboard shortcut:c-P.

Send To
Excel’s Send To submenu has only one item: Mail Recipient (as Attachment). By
selecting that option, Excel tells Entourage to send the frontmost file as a file
attachment to an email message. It’s a great feature, saving you several steps when
you’re finished working on a spreadsheet and want to email it straight to the inter-
ested parties.

Properties
Opens the Workbook Properties window, in which you can view and type in key-
words and other information about the frontmost workbook, for use later by the
Find File function (which appears when you choose File ➝ Open).
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Edit MenuFile list
A list of recently used worksheets. It’s quicker to choose from this menu than to
use the Open command.

Edit Menu
The Edit Menu gathers together all of Excel’s Edit tools into one handy place.
Many of these commands are similar to, but not identical to, those in other Office
programs’ Edit menus.

Undo
As in other programs, this command restores the last change you made; in Excel,
you can undo (or redo) many steps, taking your spreadsheet all the way back to the
way you found it. Keyboard shortcut:c-Z.

Repeat/Redo
When you’ve done something that Excel can do over and over again, you can do so
just by selecting the Repeat command. If you’ve just used the Undo command, the
Repeat menu item turns into Redo, which undoes the undo you just did. Keyboard
shortcut:c-Y.

Cut, Copy, Copy to Scrapbook
Cuts or copies to the clipboard, or copies to the Office Scrapbook the selected cell,
cells, or object. Keyboard shortcut:c-X, -C, and Shift-c-C.

Paste, Paste from Scrapbook, Paste Special
Pastes what you’ve just copied to the clipboard or to the Office Scrapbook. Paste
Special lets you exercise some control when pasting, by pulling up the Paste Spe-
cial window, where you can apply formatting. It also lets you link or embed the
clipboard contents. Keyboard shortcut:c-V, Shift-c-V.

Paste as Hyperlink
Pastes the clipboard contents into Excel as a hyperlink, either to a Web site or to a
Word document. (Requires that you’d first copied an Internet address or some text
out of a Word document.)

Fill
Fills the selected range of cells in the manner you specify in the Fill submenu.
There are several different kinds of fills:

• Down, Right, Up, Left. Fills the selected range of cells with the contents and for-
matting the first select cell, in the specified direction (see page 472 for a more
patient discussion).
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Edit Menu • Across Worksheets. If you have multiple sheets selected, this copies the selected
range of cells across all of the selected worksheets in the same place as the origi-
nal selection.

• Series. Intelligently fills the selected range of cells using the contents of the first
cell in the selected row or column as a pattern—useful for filling in a series of
dates, for example.

• Justify. Spreads the text in the leftmost cell across the selected row of cells.

Clear
The Clear menu empties out a cell or cells; although you might not know it, there
are several ways to clear cells. Here are your choices:

• All. Clears everything in the cell, including formatting, the cell’s contents, and
any comments.

• Formats. Clears just the cell’s formatting, leaving contents and comments
alone.

• Contents. Clears just the cell’s contents, leaving formatting and comments
alone.

• Comments. Clears any comments, leaving formatting and contents alone.

Delete
Deletes the selected cells or object from the sheet. If you’re deleting cells, Excel will
ask you whether you want to shift cells up or to the left, or remove entire rows or
columns.

Delete Sheet
Deletes the currently active sheet from the workbook. Be sure about it; you can’t
undo this action.

Move or Copy Sheet
Moves the selected sheet or sheets to a different location in the same workbook or
another workbook. It opens the Move or Copy window, in which you can specify
where you want to move the sheet and whether or not a copy is made.

Find
Opens the Find panel that you can use to search for a string in formulas, values, or
comments. Keyboard shortcut:c-F.

Replace
Looks for a string of text and replaces it with another.
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View MenuGo To
Opens the Go To window, which you can use to go to a specific cell. By clicking
the resulting Special button, you can also use it to select a specific type of cells,
such as those containing formulas or constants.

Links
Pulls up a window that shows information about every link in the currently active
document. If the document doesn’t have any links to other documents, this option
is blank.

Object
Lets you edit an embedded object, such as a Microsoft Graph object or a Microsoft
Organization Chart object. This menu’s name changes to reflect the kind of object
that’s embedded here, and it lets you either edit an embedded object or convert
one OLE object to a different type.

View Menu
The View menu’s commands govern what view mode the windows are in, what
toolbars are shown, and so on.

Normal
This is the standard Excel spreadsheet view.

Page Layout
The new Page Layout view. See page 467.

Page Break Preview
Switches to Page Break view mode, in which you see your worksheet as it will print
(see page 545).

Toolbox
Opens the Toolbox. See page 663.

Formatting Palette
Hides or shows the Formatting Palette.

Toolbars
Using this command’s submenu, you can hide or show 16 of Excel’s toolbars:
Standard, Formatting, Auditing, Border Drawing, Chart, Drawing, External Data,
Forms, List, Movie, Picture, PivotTable, Reviewing, Visual Basic, Web, and Word-
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View Menu Art. There is a seventeenth option in this submenu called Customize Toolbars/
Menus, which opens the Customize window, where you can select more toolbars
or create your own (see Chapter 19).

Ruler
(Page Layout view only.) Displays a ruler along the top of the Excel page.

Formula Bar
Hides or shows the Formula Bar. This is one that you should probably leave on, as
you’ll be using the Formula bar quite a bit.

Status Bar
Hides or shows the status bar at the bottom of an open workbook.

Header and Footer
Lets you edit the headers and footers that appear at the top and bottom of every
page.

Comments
Shows all comments in the document if they’re hidden, and opens the Reviewing
toolbar. If comments are already visible, choosing this hides them.

Custom Views
Opens the Custom Views window, which you can use to add, delete, or show cus-
tom views that you’ve saved.

Report Manager
Opens the Report Manager window, in which you can add, edit, delete, and print
custom reports. A report is a combination of views, scenarios, and sheets that you
can print (see page 589).

Full Screen
Turns Full Screen mode on and off. In Full Screen mode, your workbook enlarges
to take over the entire screen, and Excel hides other elements (such as toolbars, the
Formatting Palette, and the Office Assistant).

Zoom
Opens the Zoom window, in which you can choose one of seven zoom levels (25,
50, 75, 100, 125, 150, or 200 percent) for magnifying or shrinking the onscreen
representation of your spreadsheet, or you can zoom in or out to fit a selection.
You can also enter a custom zoom level (from 10 to 400 percent).
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Insert MenuSized with Window
If you have a chart embedded in its own Chart Sheet, this command ties the size of
the chart to the size of the window in which it’s embedded. If this command isn’t
checked, resizing the window has no effect on the size of the chart.

Chart Window
If you have a chart selected, this appears at the bottom of the View menu. It makes
Excel open the existing chart in a new chart window.

Insert Menu
If you want to insert something into your Excel documents, then this menu is your
best friend.

Cells
Inserts a number of blank cells equivalent to the number you’ve first selected, and
opens the Insert Cells window, which lets you set how those cells are placed.

Rows
Inserts a number of blank rows equivalent to the number you’ve first selected,
moving the selected rows down. If you have only one cell selected, Excel inserts
only one row.

Columns
Inserts a number of blank columns equivalent to the number you’ve first selected,
moving the selected columns to the right. If you only have one cell selected, Excel
inserts only one column.

Worksheet
Inserts a new worksheet into the currently open workbook to the left of the cur-
rently active or selected sheet.

Chart
Opens the Chart window, which walks you through the creation of a chart, and
then it inserts your newly minted chart either into the currently active worksheet
or into a whole new sheet reserved for the chart alone.

List
Opens the List wizard, which walks you through the creation of one of Excel’s
fancy List objects (see page 496).
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Insert Menu Page Break
Inserts a page break above the currently selected cell. If the cell is adjacent to a
manually placed page break, this command changes to Remove Page Break, which
(as you might guess) removes the break.

Function
Inserts the Paste Function window, from which you can select one of Excel’s func-
tions to insert into the currently active cell.

Name
The Name menu has five submenu choices that let you deal with names in Excel
worksheets. Names are plain-English ways of referring to a cell or selection of cells
(see page 494).

• Define. Opens the Define Name window, in which you can add or delete names
for a cell or group of cells.

• Paste. Opens the Paste Name window, which you can use to paste a named
group of cells into a formula. You can also paste a list of your defined names,
including the cells to which those names refer.

• Create. Opens the Create Names window, which lets you create names based on
labels in selected cells.

• Apply. Opens the Apply Names window, in which you can choose a name range
to replace a cell range inside a formula. That cell range has to match an existing
named cell ranges; otherwise, the Apply function doesn’t work.

• Label. Opens the Label Ranges widow, in which you can add and remove Label
Ranges as row labels or column labels. The labels you create let Excel automati-
cally apply them to formulas.

Comment
Inserts a comment attached to the selected cell or cells.

Picture
The Insert ➝ Picture submenu lets you grab images from one of six sources. You
can read about them in detail in Chapter 20, but here’s a summary:

• Clip Art opens the Clip Art gallery and lets you select a bit of Office clip art to
insert.

• From File brings up an Open dialog box, which lets you find and insert your
own picture files.

• AutoShapes opens the AutoShapes toolbar; you can start drawing in your work-
sheet using the AutoShapes tools.
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Format Menu• Organization Chart opens Microsoft Organization Chart, which lets you create
and insert your own flow charts into the currently active Excel worksheet.

• WordArt. Opens the Word Art window, in which you can create text art for
insertion into the currently active sheet.

• From Scanner or Camera. If you have the proper drivers installed (so-called
TWAIN drivers), this command can grab images from a digital camera or a
scanner and insert them into the currently active worksheet. (Very few cameras
and scanners actually work with this feature, however.)

Movie
Brings up an Open dialog box, in which you can select a QuickTime, AVI, or
MPEG movie to insert into the currently active sheet.

Object
Opens the Insert Object window, in which you can select one of the following
Office object types for insertion: a Clip Gallery item, an Equation object, a
Microsoft Graph Chart object, Microsoft Organization Chart object, a Word Doc-
ument object, or a Word Picture object (page 694).

Hyperlink
Opens the Insert Hyperlink window, in which you can insert a new hyperlink to a
Web page, a document, or an email address. If there’s already a link in the selected
cell, this command opens the link for editing.

Format Menu
The Format menu gathers together all of the commands that you’re likely to use
while altering the formatting of your sheets and workbooks.

Cells
Opens the Format Cells window, in which you can choose all kinds of formatting
options for the selected cells. This menu item changes to reflect the type of object is
selected—Picture, Object, WordArt, or AutoShape—and then opens the appropri-
ate Format window. Keyboard shortcut:c-1

Row
This menu has four options that govern the appearance of the selected row or
rows:

• Height. Opens the Row Height window, in which you can set the height of the
selected row or rows in pixels. If a worksheet is protected, this option is unavail-
able.
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Format Menu • AutoFit. Makes the selected row precisely as high as it needs to be to accommo-
date the tallest text in the row. Measured in pixels.

• Hide. Hides the selected row or rows from view (it doesn’t delete them).

• Unhide. Reveals any hidden rows.

Column
Like its sibling menu item, Format ➝ Row, this menu has five options that let you
edit the appearance of the selected column or columns:

• Width. Opens the column width window, in which you can set the width of the
selected column or columns (measured in characters).

• AutoFit Selection. Makes the selected column precisely as wide as it needs to be
to accommodate the longest text in the column. Measured in characters.

• Hide. Hides the selected column or columns from view.

• Unhide. Reveals any hidden columns.

• Standard Width. Resets the selected column or columns to the default setting of
10 characters.

Selected Chart Area
If you have a chart selected, the Select Data Series menu item appears; it lets you
format the selected chart’s area. This menu item changes to reflect the various
items selected in the chart, including data series, plot areas, labels, and legends. All
of these open the appropriate Format window.

Sheet
This menu item has four submenus, each of which deals with a formatting aspect
for the active worksheet.

• Rename. Lets you rename the currently active sheet.

• Hide. Hides the selected sheet or sheets.

• Unhide. Reveals any hidden sheets in the workbook by presenting you with a
list of hidden sheets and letting you choose those you want shown.

• Background. Lets you select a graphics file to use as a background for the front-
most sheet.

AutoFormat
Opens the AutoFormat window, in which you can select formatting from a range
of presets for the selected cells or pivot table.
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Tools MenuConditional Formatting
Opens the Conditional Formatting window, in which you can change the selected
cells’ formatting based on conditions that you define—such as changing a cell’s
text color to red when its value is negative.

Style
Opens the Style window, in which you can add, edit, or remove styles. Styles are a
saved set of formatting commands that you can apply to a cell or range of cells
with ease.

Tools Menu
Although all menu items are tools, in a sense, most are grouped together because
they have some commonality (such as the Insert and Format menu items). The
Tools menu, on the other hand, is more general in nature. It includes a mix of text
tools, sharing tools, and other miscellaneous functions that are powerful but don’t
necessarily have a common thread.

Spelling
Runs a spell check on the frontmost spreadsheet.

Dictionary
Opens the Office Dictionary floating window, which works like a real-world defi-
nitions dictionary (except for the paper cuts).

AutoCorrect
Opens the AutoCorrect window, where you can edit what Excel tries to correct
while you type, such as changing “abbout” to “about.” You can add your own
items for Excel to AutoCorrect here.

Error Checking
Checks the sheet for invalid equations and operations and provides a summary.

Share Workbook
Opens the Share Workbook window, in which you can change an ordinary work-
book into one that can be shared by many Excel users at once on a network. In this
window, you can turn workbook sharing on and off, and you can adjust how
changes to the shared workbook are treated.

Track Changes
The Track Changes controls how Excel keeps tabs of changes to worksheets and
workbooks made by your collaborators. This menu has two submenu options:
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Tools Menu • Highlight Changes. Opens the Highlight Changes window, in which you can
turn change tracking on and control which changes are highlighted.

• Accept or Reject Changes. Walks you through the changes that have been made
to a workbook, offering you the chance to accept or reject each.

Merge Workbooks
Merges all of the changes from a series of shared workbooks into one single work-
book.

Protection
The Protection menu has three submenu choices that let you choose a level of pro-
tection for the currently open worksheet or workbook.

• Protect Sheet. Protects the frontmost sheet from changes to cells, charts, graph-
ics, or Visual Basic code.

• Protect Workbook. Protects a workbook’s structure from changes such as delet-
ing, adding, hiding, or showing sheets; also keeps windows from being resized.

• Protect and Share Workbook. Protects the workbook’s change tracking and
sharing status. If the workbook is not yet shared, Excel will ask you if you want
to do so when this item is selected. If it’s already shared, this command changes
to Unprotect Shared Workbook.

Flag for Follow Up
Opens the Flag for Follow Up window, in which you can set a reminder attached to
the currently open workbook. That reminder will pop up at the time you specify to
remind you to do something with the workbook in question (provided an Office
program is running at the time).

Goal Seek
Changes the value in a cell until a formula that uses that cell reaches a value you
specify (see page 577).

Scenarios
Opens the Scenarios Manager window, in which you can add, edit, merge, and
delete a series of scenarios, which are a way of playing “what if” with an Excel
worksheet (see page 579).

Auditing
The Auditing menu controls how formulas in a worksheet or workbook interre-
late. It has five submenu choices, all of which involve colorful arrows that appear
on your spreadsheet, pointing to cells that refer to each other (see page 566).
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Tools Menu• Trace Precedents. Makes arrows point to a cell or cells that provide values for
the formula in the selected cell. Useful if you’re looking for where data comes
from.

• Trace Dependents. Points to a cell or cells where the value in the selected cell is
being used.

• Trace Error. If the selected cell contains an error caused by a bad value in a cell
that its formula references, an arrow identifies the offending cell.

• Remove All Arrows. Removes all of the arrows drawn by auditing commands.

• Show Auditing Toolbar. Hides or shows the Auditing toolbar.

Solver
Opens a Solver window that lets you attempt to solve an equation to your liking by
changing certain cell values (see page 582). In this window, you can add, edit, and
delete constraints, choose cells that the Solver is allowed to affect, and set which
cell is the target cell for the solution.

Calculator
Opens the Formula Calculator, which you can use to quickly create formulas in a
neat touchpad format (see page 489).

Macro
For power users, the Macro command contains a lot of power (see page 592). It
lets you run and edit existing macros, make new ones, and gives you access to the
Visual Basic Editor. It has three submenu choices:

• Macros. Opens the Macro window, in which you can create, edit, or delete mac-
ros. You can also use this window to debug your macros by working through
them one step at a time.

• Record New Macro. Opens the Record Macro window, which lets you set
options for your new macro and then makes Excel watch your every move while
it records what it sees.

• Visual Basic Editor. For serious Excel junkies only. Opens the Visual Basic Edi-
tor, in which you can write your own Excel macros using Microsoft’s Visual
Basic language.

Add-Ins
Opens the Add-Ins window, in which you can enable or disable various Add-Ins
for Excel. Add-Ins are conceptually similar to Photoshop plug-ins in that they add
new functions to Excel.
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Data Menu Customize
Opens the Customize window, in which you can decide what toolbars Excel should
display, create your own custom toolbars, and choose how Office presents itself
visually. (See Chapter 19.)

Wizard
The Wizard menu gives you access an Excel wizard called Conditional Sum, which
walks you through writing a formula to take the sum of specific values depending
on other values in a list.

Data Menu
This menu’s commands all process the numbers and characters in your worksheet.

Sort
Sorts the selected rows alphabetically, by date, or numerically.

Filter
The Filter menu item lets you hide rows of a list or selection according to criteria
that you specify. It has three items in its submenu.

• AutoFilter. Turns the AutoFilter pop-up menus at the top of a list object’s col-
umn. These pop-up menus contain commonly used filters.

• Show All. Removes any filtering that’s been applied to a list.

• Advanced Filter. Opens the Advanced Filter window, which lets you create your
own filters for a selected range of cells.

Form
Opens a data form window, which you can use to view, edit, add, and delete data
in a list object (see page 586).

Subtotals
Figures out a subtotal and grand total for the selected labeled column; automati-
cally inserts the appropriate cells, moving the selected cells to the right, and puts
the spreadsheet in outline mode.

Validation
Opens the Data Validation menu, which lets you control what kind of data is
entered in a cell or cell. It also lets you choose a message to display when a cell is
selected.
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Data MenuTable
Creates a data table based on a selected row and column input cell. Data tables are
useful to show how changing formula values affect a sheet’s data (see page 576).

Text to Columns
Opens the Convert Text to Columns Wizard, which walks you through the pro-
cess of converting a chunk of text in a cell (either separated by spaces or by com-
mas) into a series of columns.

Consolidate
Grabs data from one of several sources and consolidates it into a table for easy
viewing. This command opens the Consolidate window, in which you can choose
your consolidation function, and add data sources.

Group and Outline
The commands in this menu let you group data together and create outlines from
your groupings. By using grouping and outlining, you can hide and show detailed
data, grouping it in ways that help make sense of it (see page 589). For your group-
ing pleasure, the Group and Outline menu has seven submenu items.

• Hide Detail. If you have a summary row or column, this command hides the
detail rows or columns. For PivotTables, this command hides detail data in an
outer row or column field item.

• Show Detail. If you have hidden detail rows or columns, this command shows
them. For PivotTables, this command reveals detail data in an outer row or col-
umn field item.

• Group. Groups data (either cells or items in a PivotTable) together for easy
analysis and printing. Grouping cells automatically creates an outline in the
frontmost sheet.

• Ungroup. Ungroups formerly grouped data, separating group members into
individual items.

• Auto Outline. Tells Excel to automatically create an outline, which it happily
does from the formulas and cell references in the given spreadsheet.

• Clear Outline. Removes outlining, of course. If you have selected a set of cells
that are in groups, then this command removes the outline in that area. If the
selected cells are not in a group, the outline is removed from the worksheet.

• Settings. Opens the Settings window, in which you can set some options for
outlining and summarizing data in a worksheet.
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Chart Menu PivotTable Report
Opens the PivotTable Wizard, which walks you through creating a PivotTable or
editing an existing PivotTable (see page 572).

Get External Data
This menu has a collection of commands that link Excel to other data sources
(such as databases or Web-based data sources). There are seven commands in this
submenu.

• Run Saved Query. Pops up an Open dialog box, in which you can select a saved
data query to run. Excel ships with four pre-saved Web-based queries ready for
you to use.

• New Database Query. Opens the Query Wizard, in which you can create your
own database query, you mad scientist, you.

• Import Text File. Imports an entire text file into the currently open worksheet.
This command opens the Text Import Wizard, which walks you through how
Excel will parse and place the data from the text file.

• Import from FileMaker Pro. Pops up an Open dialog box, in which you can
choose a FileMaker Pro database document to import data from (see page 568).

• Import from FileMaker Server. Does the same thing as above, but for File-
Maker databases stored on a network.

• Edit Query. Edits a query that you created using Microsoft Query to get at data
in an external database. If you have used the Import Text File command to
bring in a text file, this menu item changes to Edit Text Import, and performs
accordingly.

• Data Range Properties. Opens the External Data Range Properties window,
which lets you change some of the settings for an imported bit of external data
(such as whether the query definition is saved, how data is refreshed, and how
data is laid out).

• Parameters. Lets you set options for a parameter query, a special kind of query
that asks you for some information that it will use to retrieve data from the
database’s tables.

Refresh Data
Refreshes the data in a PivotTable if the table’s source data has changed.

Chart Menu
The Chart menu appears only when a chart is selected in Excel; it replaces the Data
menu on the menu bar. Many of these options duplicate settings in the chart wiz-
ard, giving you the chance to revisit some of those choices.
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Window MenuChart Type
Opens the Chart Type window, in which you can choose a new chart type for the
selected chart (see page 531).

Source Data
Opens the Source Data window, in which you can choose a different range of cells
from which the chart draws its data.

Chart Options
Opens the Chart Options window, in which you can set all kinds of options for the
selected chart. These settings cover the chart’s titles, labels, gridlines, legends, and
axes.

Location
Opens the Chart Location window, in which you set where the chart is placed: as a
new sheet or as an object in an existing sheet.

Add Data
Opens the Add Data window, which lets you add additional cells to the chart.

Add Trendline
Opens the Add Trendline window, in which you can a trend line to your chart, or
change one that’s already there (see page 542).

3-D View
Puts up the 3-D view window, which lets you manipulate your 3D chart as if it
were a real-world, solid item by rotating it, scaling it, or changing its elevation. If
the selected chart isn’t a 3D chart, this menu item isn’t available.

Window Menu
These commands help you manage your spreadsheet windows.

Zoom Window, Minimize Window, Bring All to Front
These commands behave the same way as they do in Entourage (see page 768).

New Window
Opens a new window on the same file that’s currently open—a duplicate view of
the same spreadsheet. This arrangement lets you view two (or more) places in the
same file at the same time, scrolled to different spots and zoomed independently.
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Help Menu Arrange
Arranges all open windows so that at least a portion of each is visible—which
makes switching or dragging data between open files much easier. An Arrange
Windows dialog box opens, where you can set how those windows are arranged
(Tiled, Horizontal, Vertical, or Cascade).

Hide
Hides the frontmost workbook window without closing it.

Unhide
Displays a list of windows that have been hidden with the Hide command, which
you can then Unhide.

Split
Splits the active window horizontally and vertically into four, independently scroll-
ing panes. If the currently active window has been split, this menu command
changes to Remove Split.

Freeze Panes
If your sheet has been split into two or four panes, this command freezes the top
pane, the left pane, or both. That way, those panes stay in place while you scroll the
lower right panes—it keeps column and row titles visible while you scroll through
your worksheet. (None of this affects how the sheet prints.) This command
changes to Unfreeze Panes if you have already frozen the panes on the sheet.

Window List
The last item on the Window menu is a list of currently open workbook windows.
You can switch between them by selecting their names from this menu.

Help Menu
These commands are the same as they are in Entourage, as described earlier in this
appendix.

PowerPoint Menus
PowerPoint has many commands in common with the other Office programs.
What unique menus it has are dedicated to manipulating slides, text, and images,
which is what PowerPoint does so well.
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Edit MenuFile Menu
PowerPoint’s File menu, of course, is for working with files on your hard drive—
whether that’s creating new files, saving them, or printing them.

Project Gallery, New Presentation, Open, Close, Save, Save
As
These commands work exactly as they do in Excel; the only distinction here is the
wording of the New command (New Presentation).

Save as Web Page
Saves the frontmost PowerPoint presentation as a series of Web pages, converting
graphics and graphs to the proper kinds of graphics files and saving all of the data
in HTML tables (see page 648).

Make Movie
Creates a QuickTime movie from the frontmost open presentation (see page 646).

Web Page Preview
Shows you what your presentation looks like as a Web page. It opens a temporary
Web page version of your file in your browser.

Page Setup, Print
These commands work just as they do in Excel.

Send To
PowerPoint’s Send To submenu lets you send the currently open presentation
directly to:

• Mail Recipient. Attaches the frontmost presentation as a file attachment to an
outgoing Entourage email message, so that you can send it to whomever you
like.

• Microsoft Word. Sends the frontmost presentation’s outline to Word, where
you can edit it.

Properties, Quit
These commands work just as they do in Excel.

Edit Menu
The Edit Menu gathers together all of PowerPoint’s Edit tools into one handy
place. Many of these commands are similar to those in other Office programs’ Edit
menus, but they aren’t all the same.
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Edit Menu Undo, Repeat/Redo, Cut, Copy, Copy to Scrapbook
These commands work just as they do in Excel.

Paste, Paste from Scrapbook, Paste Special
Opens the Paste Special window, which you can use to paste the contents of the
clipboard into the presentation as a linked or embedded file. It also offers some
formatting options when pasting such a file.

Paste as Hyperlink
Pastes the clipboard contents (if you’ve copied an Internet address or some mate-
rial from Word) into the frontmost PowerPoint presentation as a hyperlink.

Clear
Clears the selected item from the frontmost presentation document.

Select All
Selects all objects on the screen. If the cursor is currently in an active text object,
selects all of the text inside that object. Keyboard shortcut:c-A.

Duplicate
Duplicates the selected object, placing the copy slightly below and to the right of
the original. Duplicating an item does not put it on the clipboard. Keyboard short-
cut:c-D.

Delete Slide
Deletes the current slide (Normal or Notes view) or the selected slides (in Slide
Sorter view).

Find
Opens PowerPoint’s Find window, which you can use to search for certain key-
words or formatting in Office files on your hard drive. Keyboard shortcut:c-F.

Replace
Searches for specific text or formatting and replaces it with other text or format-
ting that you specify. Keyboard shortcut: Shift-c-H.

Go to Property
Although few living souls have ever tried it, PowerPoint offers a unique feature
that lets you flag certain blobs of text as having been proofread, approved by the
client, and so on. To flag a piece of text in this way, drag through it; choose File ➝
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View MenuProperties ➝ Custom tab; choose from the list of properties (Disposition, Depart-
ment, and so on); turn on “Link to content”; click Add; and then click OK.

After having marked up dozens of text swatches in a slide show this way, the Edit
➝ Go To Property command is your ticket to finding those characteristics again.
When you choose this command, a tiny dialog box appears, listing all of the flags
you’d set up in this way; by double-clicking one, you jump directly to the corre-
sponding blob of text, making it easy to (for example) round up all the text blobs
that have yet to be approved before going live with the presentation.

Object
If you’ve been editing the text inside a text box or table, it’s a darned nuisance to
have to switch to the arrow tool just to adjust, say, the placement, formatting, or
size of that text box or table. This command neatly toggles back and forth between
(a) placing the insertion point inside the selected text box or table and (b) select-
ing the text box or table itself. It saves you a couple of mouse clicks when doing
frantic alternation between editing and tweaking.

View Menu
The View menu is home to the commands that govern what you see when you’re
working with PowerPoint: its view mode, whether the presentation is in color or
grayscale, and what toolbars and palettes are showing.

Normal, Slide Sorter, Notes Page, Slide Show
Switches to the corresponding view; see page 611 for details on these views.

Presenter Tools
New in PowerPoint 2004. Starts the slideshow with the Presenter Tools showing
(see page 638).

Master
The Master menu takes you to the various master elements in a presentation. It has
four submenu choices:

• Slide Master. Takes you to the Slide Master for the currently active presenta-
tion, in which you can add elements, or make formatting changes, that will
show up on every slide.

• Title Master. Takes you to the Title Master, where you can tweak the settings
for the special Title Master slide.

• Handout Master. Takes you to the Handout Master, which lets you tweak set-
tings that will appear on every handout page in the presentation.
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View Menu • Notes Master. Takes you to the Notes Master, which lets you change settings for
every notes page in the presentation.

Grayscale
Takes your presentation into, or out of, Grayscale mode, temporarily removing all
color—a useful preview if you plan to print on a standard black-and-white laser
printer. If you Control-click your presentation while in Grayscale mode, you get a
Grayscale contextual menu that offers various wacky inversions of the black/white/
gray color scheme.

Slide Miniature
Hides or shows the Slide Miniature floating window, which shows a thumbnail
image of the current slide.

Toolbox, Formatting Palette
Hides or shows these palettes, which behave the same way in Excel, PowerPoint,
and Word.

Toolbars
Hides or shows any of 13 PowerPoint toolbars: Standard, Formatting, Animation
Effects, Common Tasks, Drawing, Movie, Outlining, Picture, Reviewing, Tables
and Borders, Visual Basic, Web, and WordArt. The fourteenth option, Customize
Toolbars/Menus, opens up the Customize window, in which you can turn on or
off even more Power-Point toolbars or create your own (Chapter 19).

Ruler
Hides or shows PowerPoint’s rulers (for aligning objects on the page).

Guides
Turns the horizontal and vertical guide lines on or off (useful T-square-like lines
that help you align objects on your slide with each other). Keyboard shortcut:c-G.

Header and Footer
Opens the Header and Footer window, in which you can create text that repeats on
the top or bottom of every slide.

Comments
Shows or hides any comments (“sticky notes”) that have been placed in Power-
Point slides by you or your detractors.
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Insert MenuZoom
Opens the Zoom window, where you can choose from one of six preset values for
magnifying or reducing the onscreen representation of your slides, or enter your
own zoom percentage.

Insert Menu
Use the commands in this menu to add things to your PowerPoint presentations
or to individual slides.

New Slide
Creates a new slide after the selected slide.

Duplicate Slide
Duplicates the active slide; places the duplicate after that slide. Although no key
equivalent is given in the menu for this command, pressing Shift-c-D is, in fact,
the keyboard shortcut.

Slide Number
Adds the slide number to a text box on the active slide (not every slide—you’ll
have to use a header or footer for that purpose).

Date and Time
Opens the Date and Time window, which you can use to add the current date and
time in one of several formats to the current slide. If you want to add the date and
time to every slide, again, use a header or footer.

Tab
Inserts a tab into text at the insertion point, just as though you’d pressed the Tab
key.

Symbol
Calls up the Symbol window, in which you can choose a symbol character from
any of the currently installed symbol fonts—or from the symbols contained in a
normal font.

Comment
Inserts a comment into the currently active slide, as though it’s a “sticky note.”
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Insert Menu Slides from File
Lets you pull slides out of another PowerPoint file to insert into the currently
active presentation.

Slides from Outline
Imports a Word outline and creates slides (and slide text) from it. Each first-level
item is given its own new slide (see page 607.

Picture
The Insert ➝ Picture submenu lets you grab images from one of seven sources, as
described in Chapter 20.

Text Box
Inserts an empty text box on the active slide.

Movies and Sounds
Gives you five choices that you can use to get motion and audio into your presen-
tations.

• Movie from Gallery. Opens the Clip Gallery to show motion clips, which are
really just animated GIFs.

• Movie from File. Pops up an Open dialog box, in which you can choose a
Quick-Time movie file to insert into your presentation.

• Sound from Gallery. Opens the Clip Gallery to show all audio clips that you can
insert into your presentation.

• Sound from File. Pops up an Open dialog box, in which you can choose an
audio file to insert into your presentation.

• Play CD Audio Track. Inserts a track from the currently mounted audio CD so
that you can use it as a soundtrack.

• Record Sound. Lets you record a sound, using your Mac’s microphone, that can
be used in your presentation (see pages 591).

Chart
Launches Microsoft Graph, which you can use to create and insert a chart into
your presentation.

Table
Opens the Insert Table window, in which you can specify the size of the table that
gets inserted when you select this command.
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Format MenuObject
Opens the Insert Object window, in which you can select one of the following
Office object types for insertion: a Clip Gallery item, an Equation object, a
Microsoft Graph Chart object, Microsoft Organization Chart object, a Word Doc-
ument object, or a Word Picture object (see Chapter 20).

Hyperlink
Opens the Insert Hyperlink window, in which you can insert a new hyperlink to a
Web page, a document, or an email address. Keyboard shortcut:c-K.

Format Menu
This menu contains all of PowerPoint’s formatting commands, which let you
manipulate fonts, text alignment and spacing, and colors. When you’re working
with text, they work exactly the same as text formatting in Word (see Chapter 3).

Font
Opens the Font window, in which you can set all kinds of font options for the cur-
rently selected text: the font, size, style, color, and effects.

Bullets and Numbering
Opens the Bullets and Numbering window, in which you can select a style for your
bulleted or numbered items. You can also use this window to insert a picture or
character of your own choosing to use as a bullet.

Alignment
Aligns the selected text in one of four ways: left, center, right, or justified.

Line Spacing
Opens the Line Spacing window, in which you can set the line spacing as well as
the space before or after each paragraph.

Change Case
Opens the Change Case window, where you can change the capitalization of the
selected text: sentence case, lowercase, uppercase, title case, and toggle case.

Replace Fonts
Lets you replace one specified font in your presentation with a different font, glo-
bally, wherever it may occur—a great tactic when you move your file to a different
machine that doesn’t have the fonts you used originally.
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Tools Menu Slide Design
Brings up an Open dialog box showing PowerPoint’s design templates. You can
choose one of the files in that window to provide a design template, or you can
select an existing PowerPoint presentation and take its design template.

Slide Layout
Opens the Slide Layout window, where you can choose from one of 24 canned lay-
outs for text and graphics on the active slide. They’re the same layouts as in the
New Slide window shown on page 605.

Slide Color Scheme
Pops open the Color Scheme window, in which you can choose from a set of stan-
dard color schemes or create a custom one.

Slide Background
Opens the Background window, in which you can choose a background fill color
for the current slide (or for all of the slides in the presentation).

Colors and Lines
Opens the Colors and Lines section of the Format AutoShape window, in which
you can select a fill color, a line color and style, and an arrow style for your selected
line or shape.

[Object]
This command’s name changes to match whatever you’ve highlighted on your
slide—Picture, AutoShape, or whatever. It opens the corresponding Format win-
dow.

Tools Menu
Most of these commands work just as they do in the other Office programs.

Spelling, Dictionary, AutoCorrect, Flag for Follow Up, Tools
on the Web
These commands work just as they do in Excel.

Language
Flags the selected text as being in a given language, whether it actually is or not.
The Office spelling checker will use the appropriate language dictionary (and you’ll
get language-appropriate AutoText entries) as a result.
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Slide Show MenuMeeting Minder
Opens the Meeting Minder floating window, in which you can enter notes during a
presentation for later use (see page 635).

Macro
The Macro menu holds the two most important automation commands in Power-
Point: Macros (which opens the macro window, where you can create, edit, or
delete macros), and Visual Basic Editor (which opens the Visual Basic Editor mod-
ule, where you can write your own macros).

Add-Ins
Opens the Add-Ins window, where you can turn on PowerPoint plug-in features.
(At this writing, none exist; Office doesn’t come with any.)

Customize
Opens the Customize window, in which you can decide what toolbars PowerPoint
should display, create your own custom toolbars, and choose how Office presents
itself visually (see Chapter 19).

Slide Show Menu
This menu contains all of the slide show-related menu commands, used for pre-
paring and running a slideshow.

View Show
Starts the slideshow from the current slide.

Rehearse Timings
Runs through your slideshow, keeping track of the amount of time that it takes to
show each slide. Those times can be saved with the presentation so that it runs just
as long as it did during rehearsal.

Record Narration
Runs through your slide show while recording your voice, making a complete pre-
sentation out of what you record. The audio plays back as a series of audio clips to
the timings that you set while recording your narration.

Set Up Show
Opens the Set Up Show window, in which you can set options for the currently
open presentation.

,appc.12217  Page 797  Thursday, March 10, 2005  10:22 AM



This is the Title of the Book, eMatter Edition

798 office 2004: the missing manual

Window Menu Action Buttons
Lets you add action buttons to your slides. You can choose the kind of action but-
ton (mostly used for navigating, playing media clips, or opening files) from the
submenu: custom, home, help, information, previous slides, next slide, first slide,
last slide, last slide viewed, document, sound, and movie.

Action Settings
If you have an Action Button selected, this command opens the Action Settings
window, in which you can decide what the selected Action Button does.

Animations
Lets you choose an animation for the selected item from the submenu.

Animation Preview
Previews the animation in the little floating Animation Preview window so you can
see how it looks—and sounds, if it has audio.

Slide Transition
Opens the Slide Transition window in which you can select a transition between
slides, and you can tweak how it looks (page 629).

Hide Slide
Hides the current slide so that it’s not displayed during a slideshow.

Custom Shows
Opens the Custom Shows window, in which you can add, edit, or remove custom
slide show variations on the currently open presentation.

Window Menu
The Window menu commands let you shuffle and manipulate multiple Power-
Point windows.

Zoom Window Minimize Window, New Window, Arrange
All, Bring All to Front
These commands work exactly the same as in Excel (page 787).

Cascade
Resizes and rearranges all open windows so that one is on top of the next, and you
can see the title bar and a small proportion of each window.
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File MenuNext Pane
Rotates clockwise to the next window pane, making it active.

Window List
The last item on the Window menu is a list of currently open PowerPoint win-
dows. You can switch between them by selecting their names from this menu.

Help Menu
See “Help Menu” on page 769.

Word Menus
Word’s menus, once again, offer many functions described earlier in this appen-
dix, but there are significant differences.

File Menu
Word comes equipped with a File menu (like almost all other Mac programs),
which is mainly used for working with files on your hard drive—whether that’s
creating new files, saving them, or printing them.

Project Gallery, New Blank Document, Open, Close, Save,
Save As
These commands work just as they do in Excel.

Save as Web Page
Converts the frontmost Word document into a Web page, converting graphics
into the appropriate graphic formats (see Chapter 8).

Versions
Opens the Versions window, in which you can save and access multiple versions of
the same document (see page 186).

Web Page Preview
Shows you what your document would look like as a Web page. It opens a tempo-
rary Web page conversion of your file in your browser of choice.

Page Setup, Print
These commands work just as they do in Excel.
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Edit Menu Print Preview
Opens up the Print Preview window to show you how a Word document will look
when you print it; lets you adjust margins (see page 44).

Send To
Word’s Send To submenu has three items: Mail Recipient (as HTML), Mail Recip-
ient (as Attachment), and Microsoft PowerPoint. They’re explained on page 53.

Properties, Quit
These commands work just as they do in Excel.

Edit Menu
The Edit Menu gathers together all of Word’s Edit tools into one handy place.
Many of these commands are similar to those in other Office programs’ Edit
menus.

Undo, Repeat/Redo, Cut, Copy, Copy to Scrapbook
These commands work just as they do in Excel.

Paste, Paste from Scrapbook, Paste Special
Again, these commands do the same things as in Excel…but in Word.

Paste as Hyperlink
Pastes the clipboard contents into the frontmost Word document as a hyperlink.

Clear
Word’s Clear command is a submenu giving you a choice of how much to clear
away:

• Clear Formatting. Like the Clear Formatting option on the Formatting Pal-
ette’s Style menu, this option removes formatting while leaving text intact.

• Contents. This is the new name of the true Clear command, which deletes
selected text without copying it to the Clipboard.

Select All
Selects all text and objects in the document, ready for (for example) copying or
deleting. Keyboard shortcut:c-A.
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View MenuFind
Opens Word’s Find window, which you can use to search the open document for
text or formatting. Keyboard shortcut:c-F.

Replace
Searches for specific text or formatting and replaces it with other text or format-
ting that you specify. Keyboard shortcut: Shift-c-H.

Go To
Opens the Go To portion of the Find and Replace window, in which you can enter
a place in the frontmost Word document to go to, such as a specific page, section,
line number, footnote, or endnote. Keyboard shortcut:c-G.

Links
Pulls up a window that shows information about every link in the currently active
document (see page 60). If the document doesn’t have any links to other docu-
ments, this option is dimmed.

Object
Lets you edit an embedded object, such as a Microsoft Graph object or a Microsoft
Organization Chart object (see page 697).

View Menu
This menu’s commands govern what view mode the windows are in, what tool-
bars are shown, and so on.

Normal, Online Layout, Page Layout, Outline, Notebook
Layout, Master Document
Switches among Word’s various document views; see page 32 for descriptions.

Toolbox, Formatting Palette
Hides or shows these palettes, which work the same in Excel, PowerPoint, and
Word.

Toolbars
Shows a submenu of 17 Word toolbars that you can hide or show by selecting
them here. The last option, Customize Toolbars/Menus, opens up the Customize
window, in which you can turn on or off even more Word toolbars or create your
own toolbars (see Chapter 19).
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Insert Menu Ruler
Hides or shows the ruler in the currently active document (see page 116).

Navigation Pane
Opens and closes the Navigation Pane (page 208)

Header and Footer
Switches the currently active Word document to Header and Footer mode (and
shows the Header and Footer toolbar), in which you can enter headers or footers
that will show up at the top or bottom of every page (see page 217).

Footnotes
Shows footnotes, which also makes them available for editing (see page 221).

Comments
Shows or hides the comments pane (see page 175) and Reviewing toolbar.

Reveal Formatting
Hides or shows the Reveal Formatting mode, which pops up a balloon with all
kinds of details about the formatting where you click.

Full Screen
Turns Full Screen mode on or off. In this mode, almost all of Word’s extraneous
elements (the status bar, the toolbar, and the like) disappear, leaving the entire
screen for the enjoyment of your creative work.

Zoom
Lets you magnify or reduce the onscreen display of your document.

Insert Menu
This collection of Word commands lets you insert specialized text, entire docu-
ments or other pictures and objects into your Word documents.

Break
Inserts one of six kinds of breaks into the Word document that interrupt your text
at the insertion point: page breaks, section breaks, column breaks, and so on (see
page 144).
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Insert MenuPage Numbers
Opens the Page Numbers window, which lets you choose a place for page num-
bers that update automatically.

Date and Time
Opens the Date and Time window, from which you can insert the current date and
time in a variety of formats. The date and time appear at the insertion point, and it
can be made to update automatically to the current date and time whenever the
document is printed.

AutoText
The AutoText menu (see page 93) contains 11 commands that let you automati-
cally enter canned bits of text (such as letter salutations) at the insertion point. The
Auto-Text menu items are actually categories, with these submenus:

• AutoText. Opens the AutoCorrect window to the AutoText tab, where you can
enter your own text entries.

• New. Creates an AutoText entry from the selected text.

• Attention Line. Inserts either Attention: or ATTN: into your document

• Closing. Offers 13 ways to close a letter.

• Contact. Lets you insert the name of someone in your Entourage Address Book.

• Header/Footer. Lists 10 entries appropriate for headers and footers, such as
page numbers, the file name, and a “Confidential” stamp.

• Mailing Instructions. Offers eight mail-related entries.

• Reference Line. Inserts reply-style entries.

• Salutation. Lists four correspondence-starters.

• Signature. Inserts your name (or whatever signature you like).

• Subject Line. Inserts Subject: into your document.

Field
Opens the Field window, in which you can insert a Word field (self-updating text
code) at the insertion point (see page 237).

Symbol
Calls up the Symbol window so that you can insert a special character, like ™ or ©
(see page 224).
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Insert Menu Comment
Inserts a comment into the currently active document (see page 175).

Footnote
Opens the Footnote and Endnote window, in which you can enter footnote and
endnote information (see page 221).

Caption
Opens the Caption window, which you can use to insert a picture caption at the
insertion point (see page 244).

Cross-reference
Opens the Cross-reference window, which lets you insert cross references to items
in the document (see page 248).

Index and Tables
Opens the Index and Tables window, in which you can create various indexes,
table of contents entries, and authority citations (see page 256).

Watermark
Lets you choose an image or text to place as a watermark (faint background) on
each page of your document.

Picture
The Insert ➝ Picture submenu lets you grab images (clip art, scans, and so on)
from one of seven sources, as described in Chapter 20.

HTML Object
This menu is meant to help build Web pages, a secondary Word skill described at
length in Chapter 8. It has nine submenus:

• Background Sound. Inserts a sound of your choice that will be played back
when the page is viewed in a browser.

• Scrolling Text. Adds text that scrolls annoyingly when your page is viewed in a
Web browser.

• Checkbox. Inserts an HTML checkbox (complete with name and value) at the
insertion point.

• Option Button. Inserts an HTML option button (or radio button) at the inser-
tion point.

• List Box. Inserts an HTML list box at the insertion point.
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Format Menu• Text Box. Inserts an HTML text box at the insertion point.

• Submit. Inserts an HTML button (titled Submit by default) at the insertion
point.

• Reset. Inserts an HTML Reset button at the insertion point (for resetting a
form).

• Hidden. Inserts a hidden HTML field at the insertion point.

Text Box
Lets you draw a floating text box (see page 151).

Movie
Brings up an Open dialog box, in which you can select a QuickTime, AVI, or
MPEG movie to insert into the document.

File
Lets you insert one Word file into another—at the insertion point—just as though
you’d copied and pasted it.

Object
Opens the Insert Object window, in which you can select one of several Office
object types for insertion (see page 682).

Bookmark
Inserts a bookmark in the currently open document. The bookmark can be used to
mark text, pictures or tables (see page 242).

Hyperlink
Opens the Insert Hyperlink window, where you can insert a link to a Web page, a
document, or an email address (see page 300). Keyboard shortcut:c-K.

Format Menu
This menu contains all of Word’s formatting commands, which let you work with
text controls, alignment, and spacing.

Font
Opens the Font window, where you can make all kinds of marvelous tweaks to the
type choices of the selected (or about-to-be-typed) text. Keyboard shortcut:c-D.
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Format Menu Paragraph
Opens the Paragraph window, where you can change paragraph-level formatting
options (such as line spacing and indents). Keyboard shortcut: Option-c-M.

Document
Opens the Document window, where you can change document-level formatting
options (such as margins and how sections begin).

Bullets and Numbering
Opens the Bullets and Numbers window, in which you can control how bulleted
and numbered lists look (see page 142).

Borders and Shading
Opens the Borders and Shading window, where you can add and change borders
and shaded areas in your Word document (see page 142).

Columns
Opens the Columns window, where you can set the number of columns used in
the current document (see page 146). You can also control the column width and
spacing in this window.

Tabs
Opens the Tabs window, in which you can add, edit, and remove tab stops in the
currently open Word document (see page 122).

Drop Cap
Lets you add a drop cap to the currently open Word document (see page 111). You
can choose from one of three styles in the window that pops up.

Text Direction
Lets you choose from three text direction orientations: left to right, top to bottom,
or bottom to top. For use primarily in table cells (see page 160).

Change Case
Opens the Change Case window, where you can change the capitalization of the
selected text: sentence case, lowercase, uppercase, title case, and toggle case.

AutoFormat
Automatically adds formatting according to the AutoFormat rules that you set to
the currently open Word document (see page 99).
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Tools MenuTheme
Lets you choose a theme (complete with background and text colors, and graphi-
cal bullets) for the current Word document (see page 285).

Style
Lets you add, edit, and remove styles in the currently open Word document (see
page 137).

Background
Hides or shows the Background toolbar, which you can use to add a little color to
your Word document (see page 295).

[Object]
This menu’s wording reflects whatever’s selected in the document window (Pic-
ture, AutoShape, and so on). It opens the corresponding Format window.

Font Menu
This menu lists every font you have installed. To select a font, choose its name.
Word renders the font names in the actual font, so that you can see what you’re
selecting (see page 142).

Tools Menu
The Tools menu includes a mix of text tools, sharing tools, and other miscella-
neous functions.

Spelling and Grammar
Checks the document for spelling and grammar errors; if Word finds any ques-
tionable items, pops open the Spelling and Grammar window to give you the
opportunity to correct them. Keyboard shortcut: Option-c-L.

Thesaurus
Opens Word’s Thesaurus window, which lets you find synonyms or antonyms for
the selected word.

Hyphenation
Hyphenates the currently active Word document, which gives better spacing
between words in individual lines (see page 149).
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Tools Menu Dictionary
Opens the Word dictionary, in which you can look up a word’s definition (see
page 699).

Language
Flags selected text as being in a given language. The advantage of doing this is that
Word will thereafter apply the appropriate language dictionary for spelling checks
and AutoCorrect entries.

Word Count
Counts up the statistics for the currently open Word document: the number of
words, lines, characters, and paragraphs.

AutoSummarize
Tries to summarize the currently open Word document down to its salient points,
as described on page 235.

AutoCorrect
Opens the AutoFormat window, in which you can determine what Word tries to
automatically correct when it thinks it sees an error in your typing (see page 91). It
also lets you enter AutoText items that will fill in automatically as you type, and it
lets you set the automatic formatting that is applied to your Word documents both
as you type and if you select the AutoFormat command.

Track Changes
The Track Changes controls how word keeps tabs of changes to documents. This
menu has three submenu options: Highlight Changes and Accept or Reject
Changes.

• Highlight Changes. Opens the Highlight Changes window, in which you can
turn change tracking on, plus you can control which changes are highlighted.

• Accept or Reject Changes. Walks you through the changes that have been made
to a workbook, and accept or reject each.

• Compare Documents. Compares the open document with the original saved
version of that same document, and shows any changes that you’ve made.

Merge Documents
Merges changes that have been tracked in the currently open Word document into
the document that you choose.
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Tools MenuProtect Document
Keeps people from making the kinds of changes that you specify to a document.
You can optionally enter a password to protect the currently open document from
those changes.

Flag for Follow Up
Opens the Flag for Follow Up window, in which you can set a reminder attached to
the currently open Word document. That reminder will pop up at the time you
specify to remind you to do something with the document in which it’s embedded.

Scrapbook, Reference Tools, Compatibility Report, Project
Palette
Opens each of these Toolbox features, as described starting on page 663.

Data Merge Manager
Opens the Data Merge Manager palette, which you can use to take control over
your data merge operations (such as mail merges for mass mailings).

Envelopes
Helps you create an envelope, including things such as the delivery address and
return address. It also has an option to do a data merge, so that you can draw
addresses for your envelopes from a data file.

Labels
Lets you use Word to create mailing labels of all kinds. This command takes
advantage of Word’s plethora of mailing label templates, and it lets you format
those labels for either dot-matrix or laser printing.

Letter Wizard
Opens the Letter Wizard, which walks you through the process of creating a letter
suitable for mailing to businesses, friends, or even writing crank letters to the gov-
ernment.

Address Book
Opens the Office Address Book window (which looks suspiciously like the Entou-
rage Address Book), in which you can quickly look up contact information.

Macro
For power users, the Macro command contains a lot of power. It lets you run and
edit existing macros, make new ones, and gives you access to the Visual Basic Edi-
tor. It has three submenu choices.
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Table Menu • Macros. Opens the Macro window, in which you can create, edit, or delete mac-
ros. You can also use this window to debug your macros by stepping into them
one step at a time, or even set options for your macros.

• Record New Macro. Opens the Record Macro window, which lets you set
options for your new macro and then makes Word watch your every move
while it records what it sees.

• Visual Basic Editor. This item opens the Visual Basic Editor, in which you can
write your own Word macros using Microsoft Visual Basic.

Templates and Add-Ins
Opens the Templates and Add-Ins window, in which you can attach a different
template to the currently open Word document, plus, you can use this window to
enable or disable various Add-Ins for Word. Add-Ins are conceptually similar to
Photoshop plug-ins.

Customize
Opens the Customize window, in which you can decide what toolbars Word
should display, create your own custom toolbars, change keyboard combinations,
and choose how Office presents itself visually

Table Menu
Word’s Table menu contains a variety of commands to help you draw the perfect
table to hold your precious data.

Draw Table
Opens the Tables and Borders toolbar, which you can use to draw tables in your
Word documents.

Insert
This menu has several options that let you take a little more conservative approach
to table creation. It has six options.

• Table. Opens the Insert Table window, in which you can specify the size and
characteristics of your new table.

• Columns to the Left. Adds a column to the left of the insertion point in the cur-
rently active table. If you have more than one column selected, this command
will insert the same number of columns to the right of the insertion point.

• Columns to the Right. Adds a column to the right of the insertion point in the
currently active table. If you have more than one column selected, this com-
mand will insert the same number of columns to the right of the insertion
point.
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Table Menu• Rows Above. Inserts a row above the insertion point in the currently active
table. If you have more than one row selected, this command will insert the
same number of rows above the insertion point.

• Rows Below. Inserts a row below the insertion point in the currently active
table. If you have more than one row selected, this command will insert the
same number of rows below the insertion point.

• Cells. Inserts the number of cells that you have selected into the currently active
table. It also opens the Insert Cells window, in which you can specify how
things move around to make room for those cells.

Delete
Sometimes you want to remove a table from a document, and this menu (with its
four submenu choices) has you covered.

• Table. Deletes the currently selected table.

• Columns. Deletes the currently selected columns.

• Rows. Deletes the currently selected rows.

• Cells. Deletes the currently selected cells, and it gives you the option of how you
want to shift the remaining cells to take up the room left vacant by the now
missing cells.

Select
That’s right—there’s a special Select menu item for use with tables, and it has four
submenu options to help you select just the portions of the table with which you
want to work.

• Table. Selects the entire table. If the insertion point isn’t in a table, this option is
left blank.

• Column. Selects the column in which the insertion point is located.

• Row. Selects the row in which the insertion point is located.

• Cell. Selects the cell in which the insertion point is located.

Merge Cells
Merges two or more adjacent selected cells (including the data contained in those
cells) into one large cell.

Split Cells
Splits a cell into the number of rows and columns that you set.
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Table Menu Split Table
Plays King Solomon and splits a table at the insertion point, placing a paragraph
mark between the two new tables.

Table AutoFormat
Automatically formats the currently selected table using one of a number of color
schemes, line thicknesses, and column widths. You get to select an AutoFormat
scheme when you select this item.

AutoFit
The AutoFit menu item lets you automatically resize a table to fit a variety of fac-
tors. This menu item has five submenu selections.

• AutoFit to Contents. Makes the table’s columns resize themselves to fit the text
or numbers that you type in.

• AutoFit to Window. Makes the table resize itself to fit a Web browser window.
Useful for creating tables meant for the Web.

• Fixed Column Width. Makes the width of the selected columns a fixed value.
That way, they won’t vary in size.

• Distribute Rows Evenly. Makes the selected rows the same height.

• Distribute Columns Evenly. Makes the selected columns the same width.

• Heading Rows Repeat. Makes the selected row a heading row, which means that
it will repeat at the top of a page if the table that it’s in spans more than one
page.

Heading Rows Repeat
Does the same thing as the AutoFit ➝ Heading Rows Repeat command just above.

Convert
The two commands in the Convert submenu let you move text into tables and
back out again.

• Convert Text to Table. Converts the selected text into a table, placing the text in
one or more of the table’s cells.

• Convert Table to Text. Converts the selected table cells into regular text.

Sort
Opens the Sort window, in which you can sort your table’s contents alphabeti-
cally, numerically, and so on.
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Work MenuFormula
Sort of a mini-Excel. This command lets you insert a formula into the currently
active cell to do basic calculations.

Gridlines
Hides or shows the table’s dotted gridlines. These gridlines help you see what
you’re doing in your current table.

Table Properties
Opens the Table Properties window, in which you can set all kinds of options for
the currently selected table.

Window Menu
The Window menu provides a home for all menu commands that are window
related.

Zoom Window, Minimize Window, Bring All to Front
These commands work exactly as they do in Excel.

New Window
Opens a new window on the same file that’s currently open. That way, you can
view two (or more) places in the same file at the same time.

Arrange All
Arranges all open windows so that you can see each one. They’re stacked verti-
cally. This makes it easy to drag items between them.

Split
Splits the currently active Word window into two independently scrolling panes. If
the window is already split, this menu command changes to say Remove Split,
which removes the split screen effect.

Window List
The last item on the Window menu is a list of currently open Word documents.
You can switch between them by selecting names from this menu.

Work Menu
The Work menu is meant to be your customizable menu, to which you can add
various documents that you want to be just a menu selection away.
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Help Menu Add to Work Menu
Adds the frontmost Word document’s name to the Work menu. To remove it
from the Work menu, press c-Option-hyphen, which turns the cursor into a big
minus sign; then select the item that you want to remove from the Work menu. It
disappears promptly.

Help Menu
Contains the usual commands for Office’s Help system, as described on page 769.
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